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The Production dashboard is a tool to inspect the ink consumption, media consumption and printing time of Asanti jobs. Production dashboard 
runs inside an Internet Browser, so no additional software needs to be installed. 

Download the Asanti Sample Files via the Asanti Client (Help > Asanti Online > Download Sample Files). 

1. Create Wide Format jobs 
1. Log on with the Asanti client. 
2. File > New Wide Format Job. 
3. Select a printer. 
4. Set sheet size 700x500 mm. 
5. Import image Disco_ball_600x400.pdf. 
6. Open Frame/Product inspector. 
7. Set Copies to 2. 
8. Place the product to the sheet. 
9. Submit the job: 

• Enter a job name “Production Dashboard ex1”. 

• Select Print Files: “Make and send to printer” and click Submit. 

10. File > New Wide Format Job. 
11. Select a printer. 
12. Set sheet size 700x1000 mm. 
13. Import Disco_ball_600x400.pdf and ASANTI Visual 390x250.pdf. 
14. Place ASANTI Visual 390x250.pdf 3x to the sheet. 
15. Create a new sheet. 
16. Place Disco_ball_600x400.pdf 2x to the sheet. 
17. Submit the job: 

• Enter a job name “Production Dashboard ex2”. 

• Select Print Files: “Make and send to printer” and click Submit. 
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2. Login to production dashboard 
1. In the Asanti client, select the menu: 

Window > Go to > ProductionCenter. 

The preferred Internet browser for Production Dashboard is FireFox (for performance reasons).  
If the Production dashboard needs to be launched on a Mac or PC without an Asanti client, the URL can be typed in the address bar of the Internet 
browser (replace HOSTNAMEOFTHEASANTISERVER by the hostname or IP address of the Asanti Server.): 
https://HOSTNAMEOFTHEASANTISERVER/productioncenter 

2. Click “continue to this website” (or click Advanced, Proceed to… 
or click Advanced, Add Exception..., Confirm Security Exception). 

 
3. Enter username and password and click 

Log On. This is a local windows user on the 
Asanti Server or a Windows network user 
that has access to the Asanti Server. 

 
 
 
 
 
 
 
4. First time you login, you need to enter your first name, last 

name, e-mail address, language and preferred units. Click “Save 
and Continue”. 
 
 

https://hostnameoftheasantiserver/productioncenter
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3. Switch Printed layouts VS Printer Usage view 
At the top left, click the dropdown icon, it contains 2 viewing options: 

• “Print(ed) layouts” view shows all layouts created/printed in a certain timeframe (Layout-oriented 
dashboard). 

• “Printer usage” view shows a Printer-oriented dashboard, it reports on printer level. This view shows 
only actual printed data, no predictions. So data will only be shown for printers that report actual 
usage (Tauro). 
 

Select “Printed layouts” from the dropdown. 

 

The very first time you switch to "Printer Usage" view it can take up to 15 minutes before data is shown. This is normal, Asanti needs to generate 
a database for this view and copy all log events from jobs from the past. It is best to keep the browser open until data is shown (window can be 
minimized). Next times you switch to the "Printer Usage" view, data will be shown very fast. 

 

4. Print Layouts view: Filter and sort 
By default Production dashboard filters layouts by print date. The header shows “Printed Layouts” (1), the line underneath 
the date filter shows “Printed: …” (2). Only Tauro printers report when a layout is printed. If no jobs are printed on Tauro 
during the date filtered (today), the Production Dashboard will show no jobs.  

 

 

When a job is printed more than once e.g. yesterday 2 copies and today 3 copies on Tauro, Production Dashboard will show the job when filter is 
set to “Date printed” today. The Actual ink, media, time consumption shown in production Dashboard will reflect only the prints done during the 
print date filter (today = 3 copies). 



Tutorial Working with the Production Dashboard 

 

 
   Page | 4  

 

1. Change the filtering to “Date Created” (1). Production Dashboard 
shows all Asanti jobs rendered and sent to the printer 
(Tauro/Jeti/Anapurna/…) that have creation date today.  
The header shows “Print Layouts” (2), the line underneath the date filter 
shows “Created: …” (3). 
 

 
2. Click the dropdown list with the label “Today” (4). Change the 

dropdown to “Last month” (5). This shows up all jobs created 
from the same day last month up to now (e.g. from 11 December 
up to 11 January). If required, the date picker (6) can also be 
used to specify a timeframe. 

 

3. On the right top of the window click . This sorts the jobs by 

creation date. Click . This sorts the jobs by print date. Click 
. This sorts the jobs alphabetically.  

4. Click the dropdown list with the label “No Grouping” (7). This 
grouping filter allows you to group the jobs by Job Name, Order 
Number, Company, Printer and Media.  

5. Select “Group by job” (8).  
 

 
 
6. In the “Search Job Name” field, enter the text “Production 

Dashboard ex” (9). This shows all job names that contain the 
text “Production Dashboard”. 

7. Select job “Production Dashboard ex1” (10). This shows in the 
right pane (Print Layouts pane) all layouts for this job. 
 

Jobs that are deleted in Asanti show no thumbnails in Production Dashboard. 
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5. Print Layouts view: Example filter “Date created” vs “Date printed” 
Example: job2 is created yesterday, printed yesterday 2 copies, today 3 copies on Tauro 

• Filter “date printed” today: Job2 is shown, Actual ink, media, time consumption shown in production Dashboard reflects the prints from 
today (3 copies). 

• Filter “date created” today: Job2 is not shown as it was created yesterday. 

• Filter “date created” yesterday: Job2 is shown, Actual ink, media, time consumption shown in production Dashboard reflects all prints 
(5 copies). 
 

Asanti Jobs sent to the printer Printer Creation date Print date 

job1 Tauro Yesterday Yesterday 5 copies 

job2 Tauro Yesterday 
Yesterday 2 copies 
Today 3 copies 

job3 Tauro Today Today 7 copies 

job4 Anapurna Today Today 8 copies 

    
Production Dashboard Filter Jobs shown in dashboard (Actual consumption) 

Date Printed Today job2(3 copies),job3(7 copies) Job4 is not shown as Anapurna doesn’t report actual consumption. 

Date Printed Yesterday job1(5 copies),job2(2 copies)   

Date Printed Yesterday to Today job1(5 copies),job2(5 copies),job3(7 copies) 

Date Created Today job3(7 copies),job4(No actuals, only estimations)   

Date Created Yesterday job1(5 copies),job2(5 copies)   

Date Created Yesterday to Today job1(5 copies),job2(5 copies),job3(7 copies),job4(No actuals, only estimations) 
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6. Print Layouts view: Inspect the results 
1. Job “Production Dashboard ex1” shows 1 thumbnail 

because the job contains only 1 layout. Next to the 
thumbnail some additional info is shown: 

• DQS level (1): For Tauro printers an  icon is shown, 
this indicates Sheet Level DQS. With other printers, 

an  icon is shown, this indicates non-DQS. A green icon indicates Image level DQS.  

• Print Layout name (2): the job name followed by the number of the layout. 

• Run Length (3): Run length of a layout as requested in the Asanti job (Print Layout inspector).  
When the job is reported as being printed, the run length is no longer visible here, it will be replaced by x copies (actual copies). 

• Media (4). 

• Coverage (5): Printed area (7) (in %) of the jobs media size (8). The media size takes the expected run length into account  
When the job is printed it takes the actual copies Into account. 

• Ink Usage (6): Ink prediction, taking run length into account.  
When the layout is reported as printed (Tauro), this is the actual ink usage, 
taking actual copy count into account. 

• Creation date (print date when job is reported as being printed), Printer, Job 
name, Quality and Company. 

 

When the job is not reported as printed, the info shown are expected values, not actual 
values. Currently only Tauro can report back when a job is printed. 
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2. In the left pane Select job “Production Dashboard ex2”. For this 
job, 2 thumbnails are shown because the job contains 2 layouts. 
If no layouts are selected, the bottom pane (info pane) shows the sum of the coverage and ink usage of all layouts in the Print Layouts 
pane (e.g. 1.4 m2 used media). 

 
3. Click in the area next to the thumbnail of Print Layout 1 as 

indicated in the screenshot. This selects the layout (Light blue 
color). If 1 or more layouts are selected, the bottom pane (info 
pane) shows the sum of coverage and ink usage of the selected 
layouts (e.g. 0.7 m2 used media for selected Print Layout 1). 

4. Click in the area next to the thumbnail of Print Layout 2. This 
adds Print Layout 2 to the already selected layouts. 
The info pane shows the sum of coverage and ink 
usage for layouts 1 and 2. 

5. Click again in the area next to the thumbnail of 
Print Layout 2. This deselects Print layout 2. 

6. Click "Clear Selection", this deselects all Print Layouts. 
 

7. A green circle (1) next to the thumbnails indicates image DQS 
level. For Tauro Sheet DQS level is used (orange circle). 

8. Click on the thumbnail of Layout 1 (2). 

• For Sheet DQS jobs (Tauro) this shows all sheets placed on the Print 
Layout. 

• For image DQS jobs, this shows all Images placed on the current Layout.  

9. Click on the thumbnail to return to Print Layout view. 
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7. Print Layouts view: Show actual values for Tauro 
For all printers, the expected values can be shown in Production dashboard. With Tauro also the actual values are communicated to Asanti after 
printing. In most cases, the actual values returned by Tauro are the same as the expected values calculated by Asanti. The values will however be 
different if on Tauro GUI the Tauro operator changes the amount of copies or the density.  

If you created jobs for Tauro you can execute following steps. 

1. In Production Dashboard select job Production Dashboard ex1. 
The expected values in the info pane are set to: 

• Run Length: 2 

• Media usage: 0.7 m2 

• Ink usage e.g. 6.364 ml 

 

 

 

 

 

 

 

 

 

 

2. On Tauro change number of copies of job Production 
Dashboard ex1 to 1.  

3. Print the job 1x. 
4. When printing is finished, select job Production Dashboard ex1 

in Production Dashboard. 
5. Refresh the Internet Browser. When a Print Layout or the info 

pane shows the  icon, the values shown in the info pane are 
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the actual values after printing and not the estimates anymore. 
The following info is shown for this job: 

• Indicator that actual values are 
displayed (1). 

• Coverage: Printed area (in %) of 
the jobs media size. The media 
size takes the actual copies Into 
account. The actual ink 
usage/m2 Is shown in the 
details (2) 

• Actual printed copies/good 
copies/wasted copies (3).  

• Actual total ink usage/good ink 
usage /wasted ink usage (4).  

• Actual total media usage/good 
media usage /Wasted media 
Usage bad copies (5).  

All actual values are different from the expected values because the Tauro Operator has decided to only print one copy instead of two. 

• Total Print Time (6). 

•   Date Printed (7). 

Wasted copies and wasted media can be considered true waste because they cannot be re-used. Typically wasted copies are the result of a 
printer crash. In normal circumstances, the number of good copies should equal the total printed copies.  
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In Asanti 6.1 the option “Production Time” has been added.   

• “Production Time”     = Total time from initiating print on GUI untill end of last    

     print  

• “Print Time”        = Time from start Shuttle Movement untill end of that copy * number of copies  

 

On Tauro systems: 

• Hold (hand icon): printer remains in "printing" status => printing time continues to add up 

• Pause (pause icon) and Stop (square icon): printing is effectively stopped => printing time is paused. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Tutorial Working with the Production Dashboard 

 

 
   Page | 11  

 

8. Print Layouts view: Export Report 
1. If you are only interested in the jobs printed the last month, 

change the filtering to “Date Printed” (only for Tauro printers). 

 
2. Click the export button (1). 
3. Click export (2). The jobs included in the Excel document are all 

jobs printed last month (or created last month when filter by 
creation date).  

 
 

4. Open the Excel file. It shows the same values as displayed in the 
Production dashboard. 
The values in the Statistics tab are for customer usage. The values in the other tabs (e.g. Jeti 
Tauro H 2500 LED tab) are only for service technician usage. E.g. to see for a specific print task 
what’s the value of the UV leading. 

Only Tauro printers can communicate back to Asanti the actual values after printing.  
For other printers, actual values will be empty. 

 

When you want to make comparisons of e.g. ink usage of each month it is best to view and export results from the Production Dashboard 
“Printer usage” view. See: 0   
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Printer Usage view: Filter (Next page). 
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9. Printer Usage view: Filter 
The Printer Usage view reports on printer level. 

1. At the top left, click the dropdown icon, select “Printer Usage”. 

 
The date and printer filters are reflected on the Data Page. The Data Page is a single page which consists of 2 parts: 

• Tile View (top) 

• Comparative Charts 

 
Different tiles show data for the filtered printers and period: 

• Printers: The number of filtered printers. 

• Color usage:  
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• Total color (good + wasted copies) + primer inks used (L) (A).  
This includes the ink used for maintenance (e.g. purging).  
White ink usage is not included. A copy is marked as wasted when e.g. a head crash has occurred. 

• “Total Color Usage”/”printed m2 media” (B) (e.g. 0.027*1000/6 = 4.5 ml/m2). 
 

 

 

 

 

 

 

 

 

• White Usage:  

• Total white ink used (L). This includes the ink used for maintenance (e.g. purging). 

• “Total White Usage”/”printed m2 media” (e.g. 0.005*1000/4.37=1.1 ml/m2). 

• Printing time:  

• Total printing time (C) reported by Tauro. 

• m2 media/hour (D) e.g. 6m2/(8.2minutes/60) = 43.9 m2/h. 
 

 

 

 

 

 

• Printed media: This excludes the media used for printing 
technical/calibration images 

• Total m2 media printed (e.g. 6 m2) = good + waste m2.  
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• Waste m2 media printed (e.g. 1 m2). Tauro reports media as waste when e.g. a head crash occurs.  

 

• Printed layouts: number of layouts that are printed (copy counts are not taken into account). Note that a layout (print bed) can contain 
multiple sheets. 

• Copies: Total copies of all layouts, this is not the same as total copies of all sheets as a layout can contain multiple sheets. 

 
2. Filter last year (1),  
3. Select 1 printer e.g. Jeti Tauro H3300 LED (2) 

 

 

 

 

 

4. Tiles and charts can be hidden if required. Click the “data page 
filter” (top right) (3) 

5. Uncheck “Printer” (4) and click Save. The Printer tile is now 
hidden. 
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6. Scroll down to the Overall Ink usage chart, it shows you the ink 
usage per ink and the total ink usage (color + primer + white) of 
the last year. This graph includes ink used for maintenance. 
 

 
 
 
 
7. Scroll down to the Maintenance ink usage chart, it shows you 

the total ink used for maintenance tasks. Maintenance ink is ink 
used for tasks initiated on the Tauro:  

• Purging,  

• Technical images, 

• Calibration images 

Maintenance info is only reported when using FrontEndManager 
2.7.0 or later (Not released yet Jan 2020). FrontEndManager is a component that runs on the Tauro pc. With older versions of 
FrontEndManager the Maintenance activities statistics are always 0. 

 

8. If you want to know the total values for e.g. 1 Month, change 
the filter: Select the date picker, filter e.g. 1-31 March 2019. 
Totals are now shown for March 2019. E.g. 27093 m2 was 
printed that month. Total used ink for jobs=141.33L color + 
77.88L white. 
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9. Scroll to the Ink consumption over time chart, it shows you the 
ink usage per day. Days that show a thick gray line represent 
non-working days. 
 

 
 
 
 
 
 

 

The “Printer usage” view gets automatically updated every minute so there is no need to manually refresh the web page. 

 

10. Printer Usage view: Export report 
1. Click the export button (1). 
2. Select date range “Last Year” (2). 
3. Uncheck “Detailed data”. When checked, the excel report will 

include more info about each print task on the Tauro. 
4. Click export (3). The report includes the ink, time and media 

usage reported by all Tauro’s from last year.  
 
 

5. Open the Excel file. The excel file contains 3 tabs:  

• Ink: Each row represents the total ml usage of 1 ink (excludes ink used for maintenance e.g. purging) on 1 day for 1 printer. 
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• Media: Each row represents the usage (m2) of 1 media (includes good and waste prints, excludes media used for maintenance e.g. 
technical images) on 1 day. 

• Maintenance: Each row represents the total ml usage of 1 ink for maintenance (e.g. ink spitting) on 1 day. 
 

6. The PivotChart functionality in Excel can be used to extract 
additional charts. Select the ink tab. 

7. Click row number 2 to select the first row with data (1). 
 

8. Browse to the bottom of the table, shift click the row number of 
the last row. This selects all rows with data (2). 
 

 
 
9. Click the insert tab, click PivotChart. 

 
10. Click OK. 
11. Drag PivotChart field “Day” to the AXIS pane (1). 
12. Enable PivotChart field “Amount” (2). 
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13. In the row labels, open a year and multiple quarters to see more 
details in the graph. 
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